
The Calendar utility included with hDC First Apps does not run correctly under Memphis. If you try to load the 
hDC Calendar utility, you will be able to see the calendar, but none of its features will be available.
If you are in the United States, contact Express Systems at (206) 728-8300 for more information. Outside the 
United States, call the product support telephone number that came with your copy of hDC First Apps.    



Important

Stacker versions 4.0 or earlier do not support long file names. Do not use these versions of Stacker to compress, 
optimize, resize, uncompress, or change the expected compression ratio of a drive that has long file names. If 
you do, you will truncate long file names to eight-character names with three-character extensions. In addition, 
Stacker versions 4.1 and earlier are unable to compress drives that use large drive support (FAT32).
For further information, refer to Stac's World Wide Web site at:
http://www.stac.com/ 



This version of Do It On Your Desktop does not run correctly under Memphis. If you try to start Do It On Your 
Desktop, the program will stop running. To use Do It On Your Desktop, obtain an updated version of the program.
If you are in the United States, contact Moon Valley Software at (800) 473-5509 for more information. Outside 
the United States, call the product support telephone number that came with your copy of Do It On Your Desktop.



Lotus ScreenCam versions 2.0 and earlier play Windows 3.1 screen movies under Memphis but do not record 
Memphis screen activity. For information about updated versions of ScreenCam that provide this functionality, 
contact Lotus.
If you are in the United States, call (800) 343-5414. Outside the United States, call the product support 
telephone number that came with your copy of ScreenCam. 



This version of Peachtree Accounting may not run correctly under Memphis.
If you are in the United States, call (800) 336-1420 for information about obtaining a version of this program that
is fully compatible with Memphis. Outside the United States, call the product support telephone number that 
came with your copy of Peachtree Accounting.



Adobe Photoshop version 3.0 may not run correctly under Memphis. Changing default settings in common dialog 
boxes may result in problems. For example, in the Open dialog box, you may encounter problems if you change 
the setting in List Files Of Format Type.
If you are a registered Adobe Photoshop user, Adobe will notify you when an update that corrects this problem is 
available. If you have not yet registered your copy of Adobe Photoshop, contact Adobe at (800) 87-ADOBE (800-
872-3623). Outside the United States, contact your local Adobe distributor or authorized reseller. 



This version of Crystal Walls may not run correctly under Memphis. If you run Crystal Walls, you will be able to 
see pictures, but they will not be animated. To use Crystal Walls, obtain an updated version of the program. Call 
the product support telephone number that came with your copy of Crystal Walls. 



This disk utility was written for Windows 3.1. Some of this utility's features may not function correctly under 
Memphis.
For information about obtaining updated disk utilities written for Memphis, contact the manufacturer of this 
utility or your software vendor. 



This virus protection utility was written for Windows 3.1. Some of this utility's features may not function correctly
under Memphis. You will be able to detect viruses, but not clean them. This utility may also detect virus activity 
where none occurs.
For information about virus utilities that were written for Memphis, contact the manufacturer of this program or 
your software vendor. 



If you are using the Access Developer's Toolkit version 2.0 to create installation disks that will be used under 
Windows 3.1, you must create those disks while running Windows 3.1.
If you create installation disks while running Memphis, those disks will contain Memphis system components. If 
those installation disks are used on a Windows 3.1 system, the Windows 3.1 files will be replaced with their 
Memphis equivalents, causing serious problems.
If anyone using your program will be running Windows 3.1, create the setup disks while running Windows 3.1. 



If you are using the Visual Basic Setup Toolkit version 3.0 to create installation disks that will be used under 
Windows 3.1, you must create those disks while running Windows 3.1.
If you create installation disks while running Memphis, those disks will contain Memphis system components. If 
those installation disks are used on a Windows 3.1 system, the Windows 3.1 files will be replaced with their 
Windows 95 or Memphis equivalents, causing serious problems.
If anyone using your program will be running Windows 3.1, create the setup disks while running Windows 3.1. 



If you run the Aris MPC Wizard under Memphis using a color palette higher than 256 colors, the program may 
stop running. 
Click here        for information about setting your palette to use 256 or fewer colors.



Because of the many new features included in Memphis, some Windows 3.1 user interface replacements may not
function correctly. 
Running a Windows 3.1 user interface replacement with Memphis causes some features of the interface to be 
unusable.
For more information about this replacement interface, contact the manufacturer or your software vendor. 



This program was designed to run only on Windows NT. It takes advantage of high-end Windows NT interfaces or 
features that are not available in Memphis.
For information about a version of this program that is designed for Memphis, contact the program's 
manufacturer or your software vendor. 



Do not run the Microsoft Sound System version 2.0 setup program under Memphis. Instead, set up the Microsoft 
Sound System hardware by carrying out the following procedure.

To set up Microsoft Sound System hardware under Memphis

1 Click Start, point to Settings, and then click Control Panel. 
2 Click Add New Hardware. 
3 Install your sound card by following the instructions on your screen.



Because of the many new features included in Memphis, some Windows 3.1 utilities, such as TabWorks, need to 
be upgraded or used differently to function correctly under Memphis.
Although you can run your current version of TabWorks under Memphis, it is recommended that you do not use it
as your default interface. Instead, start TabWorks by clicking Start and then clicking Programs. You will be able 
to use all of the items currently in your TabWorks book, but you will be unable to add a new item to your book by 
using File Tracking or by dragging the item. A new version of TabWorks for Memphis is available, and it includes 
many new features that capitalize on the more powerful Memphis operating systems.
If you are in the United States, contact XSoft at (800) 909-4446 for more information. Outside the United States, 
call the product support telephone number that came with your copy of TabWorks. 



The tutorial for PFS:Window Works may not run correctly if your taskbar setting is Always On Top. If you try to 
run the tutorial with the taskbar on top, the program may stop responding. To resolve this problem, change the 
taskbar setting before running the tutorial.

To change your taskbar setting
1 Click Start, point to Settings, and then click Control Panel.
2 Click to clear the Always On Top check box. 



The MaxTime, FN-esse, and Toshiba sound control programs that were written for Windows 3.1 prevent the 
Memphis taskbar from correctly displaying buttons that represent running programs. If you decide to use any of 
these programs, buttons representing running programs will not appear correctly on the taskbar. To switch 
between open programs, press ALT+TAB.
If you are in the United States, call your local Toshiba product support organization for more information, or call 
(800) 999-4273. Outside the United States, call the product support telephone number that came with your copy
of this program. Or visit the Toshiba World Wide Web site at http://www.toshiba.com.



Some features of this version of Central Point Anti-Virus do not function correctly under Memphis. 
If you are in the United States, contact Symantec Corporation for information about obtaining a version of this 
program that is designed for Memphis. You can reach Symantec at (800) 441-7234 or (541) 334-6054. Outside 
the United States, call the product support telephone number that came with your copy of this program. 



Family Tree Maker version 2.0 may not run correctly if your taskbar setting is Always On Top. If you try to run 
Family Tree Maker with the taskbar on top, the program will stop responding. To resolve this problem, change the
setting before running the program.

To change your taskbar setting 
1 Click Start, and point to Settings, and then click Taskbar.
2 Click to clear the Always On Top check box.
If you are in the United States, contact Banner Blue Software at (510) 794-6850 for information about obtaining a
version of this program that is designed for Memphis. Outside the United States, call the product support 
telephone number that came with your copy of this program. 



Because of changes to the Windows operating system, TrueEffects may not work under Memphis.
If you are in the United States, contact Mindscape Direct at (510) 652-5464 for more information. Outside the 
United States, call the product support telephone number that came with your copy of TrueEffects.



This version of NCD PC-Xware may not function correctly under Memphis. If you install PC-Xware on a computer 
that is running Memphis, your computer may not start.
If you are in the United States, contact NCD at (800) 296-3359 for more information about this program . Outside
the United States, call the product support telephone number that came with your copy of this program. 



Wired for Sound version 1.0 does not function correctly under Memphis.
If you are in the United States, contact Aristo-Soft, Inc. at (510) 426-5344 for information about obtaining an 
upgrade. Or fax your name and mailing address to (510) 328-1117, or email wfs@pacbell.net for upgrade 
information. Outside the United States, call the product support telephone number that came with your copy of 
Wired for Sound. 



Older versions of Icon Hear It may not run under Memphis. When you try to close older versions of Icon Hear It, 
the program may stop running. 
If you are in the United States, call Moon Valley Software at (800) 473-5509 or (805) 781-3890, or fax (805) 781-
3898 for information about obtaining a version of this program that was designed for Memphis. Outside the 
United States, call the product support telephone number that came with your copy of Icon Hear it.



If you are running DaVinci eMAIL and you use a network printer, make sure the network path is associated with a
printer port (this is also referred to as "capturing" a printer port). Otherwise, you may encounter problems when 
you print to a network printer.
Click here        for information about capturing a printer port.

If you are running DaVinci eMAIL version 3.0, you cannot add user licenses in Memphis. To add new users, you need 
DaVinci eMAIL version 3.1.

If you are in the United States, contact ON Technology Corporation for more information. You can reach the 
company at the following numbers: phone (800) 328-4624; fax (617) 692-3539. Outside the United States, call 
the product support telephone number that came with your copy of DaVinci eMAIL.



The 16-bit version of the Windows NT management tools does not run under Memphis. To resolve this problem, 
use the 32-bit version of these tools, which is located on The Microsoft Network.



If you installed Microsoft Exchange, which is included with Memphis, you will be unable to run older versions of 
Microsoft Mail. When you install Microsoft Exchange, some Microsoft Mail files get replaced. Older versions of 
Microsoft Mail cannot use the new versions of these files. 



Nickelodeon Director's Lab may display some error messages at the end of its setup program. If this occurs, you 
must close the setup program manually.
After the setup program has added new shortcuts, you may see a message that says, "Setup Message: Script or 
DLL has been corrupted. Unable to load dialog template: 'mscuistf.dll: 2'." If this message appears, carry out the 
following procedure.

To close the Nickelodeon Director's Lab setup program
1 Press CTRL+ALT+DEL.
2 In the Close Program dialog box, select Director's Lab setup program, and then click End Task.
This ends the error messages and closes the setup program. 



The WorldView CD-ROM by Aris Entertainment includes a modified version of Microsoft Video for Windows. 
Because this modified version was not configured properly, it may erroneously report that a device driver is 
corrupted and may advise you to call product support services.
If you are following the instructions in the Readwrld.txt file, you may see an error message on your screen 
indicating that the source file or destination disk may be corrupted. If you receive such an error message, carry 
out the following procedure.

If you received a message that says the Iccvid.drv file is corrupted
1 Click Start, and then click Run.
2 In Open, type: command /c copy x:\vfwsetup\iccvid.drv %windir%\system /y 

where x is the letter of your CD-ROM drive.
3 Click OK.
4 Reinstall Video for Windows by following the instructions in the Readwrld.txt file.



You may experience problems running Turbo Debugger version 3.1 for Windows under Memphis.
If you are in the United States, contact Borland International, Inc. for information about obtaining an updated 
version of this program. To place an order, call (800) 331-0877. For a list of technical support phone numbers, 
call (800) 523-7070. Outside the United States, call the product support telephone number that came with your 
copy of Turbo Debugger.



Older versions of PrintCache were designed to modify parts of Windows 3.1 printer drivers. If you run older 
versions of PrintCache under Memphis, none of the printer drivers installed on your computer will work.
For more information about this program, contact your software vendor.



If you use a network printer, make sure the network path is associated with a printer port (this is also referred to 
as "capturing" a printer port). Otherwise, you may encounter problems when you print to a network printer from 
this program.
Click here        for information about capturing a printer port.

For more information about this program, contact the manufacturer or your software vendor.



This version of pcAnywhere does not function correctly under Memphis.
If you are in the United States, contact Symantec Corporation for information about obtaining pcAnywhere 
version 2.0, which was designed for Windows 95 and Memphis. You can reach the company at (800) 441-7234 or 
(541) 334-6054. Outside the United States, call the product support telephone number that came with your copy
of pcAnywhere. 



To capture a printer port

1 Click here        to open the Printers folder.
2 Select the icon for the printer you are using.
3 On the File menu, click Properties.
4 Click the Details tab. 
5 In Print to the following port, select the port specified.

If the specified port begins with the letters LPT, the port has been captured. Close the Properties dialog box. 
If the specified port begins with backslashes (\\), write down the text that appears in Print to the following 
port, and then click Capture Printer Port. 

6 In Device, select a printer port that you are not already using.
7 In Path, type the text you wrote down in step 5.
8 Select the Reconnect at logon check box if you want to permanently capture this printer port, and then click 

OK.
9 In Print to the following port, select the port you chose in step 6, and then click OK.

Note
For Help on an item, click    

    at the top of the dialog box, and then click the item.



Thumbelina may not install correctly under Memphis. You can resolve this problem by adding a line to your 
System.ini file. This line tells the setup program that Memphis is Windows version 3.1.

To enable Thumbelina Setup to run

1 Print or write down these instructions.
2 Click here        to start System Configuration Editor.

3 On the Window menu, click the Win.ini file.
4 In the [Compatibility] section, type the following text on a line of its own:

DSHELL=0x00200000
5 On the File menu, click Exit.
6 To save your changes to the Win.ini file, click Yes.
8 Restart your computer, and then run the Thumbelina Setup program.
9 After Thumbelina is installed, carry out steps 2 through 6 again, but this time, remove the text that you 
added to the Win.ini file. 



If you switch between standard and enhanced environments in MCS Stereo version 1.05 under Memphis, the 
mixer controls will be disabled. To re-enable them, close the program, and then reopen it. 
If you are in the United States, contact Animotion Development Corp. for information about obtaining a version 
of this program that is designed for Memphis. You can reach the company at the following numbers: phone (205) 
591-5715; fax (205) 591-5716; technical support BBS (205) 591-5795. Outside the United States, call the product
support telephone number that came with your copy of MCS Stereo. 



The McAfee network management software NetTools versions 5.1 and 5.2 contain the program Appman.exe, 
which is a replacement for Windows 3.1 Program Manager. Appman.exe may not function correctly under 
Memphis.
If you are in the United States, contact McAfee Associates, Inc. for information about obtaining a version of this 
program that is designed for Memphis. You can reach the company at the following numbers: phone (408) 988-
3832; fax (408) 970-9727; technical support BBS (408) 988-4004. Outside the United States, call the product 
support telephone number that came with your copy of NetTools.



If you run Adobe Acrobat version 1.0 under Memphis, you may receive a general protection fault error. If this 
occurs, upgrade to the latest version of Acrobat. 
If you are in the United States, call (800) 272-3623 for information about obtaining the latest version of Acrobat. 
Outside the United States, call the Adobe product support telephone number that came with your copy of 
Acrobat. 



The device disabling feature included in the Compaq utility Secure does not function correctly under Memphis. 
For secure device disabling, use Compaq F10 Setup in conjunction with the setup password. You can also disable 
a device by carrying out the following procedure.

To disable a hardware device

1 Click here        to display the System Properties dialog box.
2 Click the plus sign beside the hardware type, and then double-click the hardware.
3 In the Device Usage area, select the Disable in This Hardware Profile check box.

If there is more than one configuration listed in the Device Usage area, select the configuration check boxes 
for the devices you want to disable.

Note
After the device is disabled, the resource settings may not be free unless you have Plug and Play hardware.

To free the resource settings used by this device, click Related Topics.

{button ,AL("A_FREE_RESOURCES")} Related Topics



RemindMe version 1.0 does not run under Memphis.
If you are in the United States, contact Velocity Development Corp. for more information about this program. You 
can reach the company at the following telephone number: (415) 274-8840. Outside the United States, call the 
product support telephone number that came with your copy of RemindMe.



This program was designed for Windows 3.1. Because of changes in the Memphis operating system, some of the 
program's features, such as the floppy RPM test, RAM test, and video tests, do not function correctly.
If you are in the United States, contact Quarterdeck Select. for information about obtaining a version of this 
program that is designed for Memphis. You can reach the company in the following ways: phone (800) 678-3600;
fax (813) 523-2335; technical support (573) 875-0932; or via the Internet at:
http://www.quarterdeck.com
http://support.qdeck.com
Outside the United States, call the product support telephone number that came with your copy of this program.



Pixar's Typestry may not run under Memphis. To fix this problem, create a Win32s.ini file for it, and then save it in
your System folder.

To create a Win32s.ini file

1 Click here        to start Notepad.
2 In Notepad, type the following:

[WIN32s]
Version=1.3

3 On the File menu, click Save.
4 Name the file Win32s.ini, and save it in the System folder, which is located in the folder that contains your 

Memphis files.
If you are in the United States, contact Pixar, Inc. for more information about this program. You can reach the 
company at the following numbers: phone (800) 888-9856 or (510) 236-4000; fax: (510) 236-0388; technical 
support (800) 937-3179. Outside the United States, call the product support telephone number that came with 
your copy of Typestry. 



SpaceManager version 1.53 or earlier does not run correctly under Memphis. Although you can install 
SpaceManager in MS-DOS mode, most of the program's utilities will not function correctly.
Because SpaceManager is no longer manufactured, it is recommended that you obtain a similar program that 
was designed for Memphis.



You must install or run this game from the MS-DOS command prompt. If you attempt to run or install it by 
clicking Start, and then clicking Run, the game will not install or run correctly.

To run this game
1 Click Start, point to Programs, and then click MS-DOS Prompt.
2 Type the command that installs or runs the game.



Super PC-Kwik version 4.0 does not run correctly under Memphis. The program can cause irreparable problems 
on hard disks that were compressed by using DoubleSpace. 
It is recommended that you do not install Super PC-Kwik version 4.0 under Memphis.
If you are in the United States, contact MicroDesign International for more information about this program. You 
can reach the company at the following numbers: phone (800) 274-5945; fax (407) 677-8365. Outside the United
States, call the product support telephone number that came with your copy of Super PC-Kwik.



Important

This version of PC Tools was designed to work with MS-DOS or Windows 3.1. Because of changes to the Windows 
operating system, some of this program's features do not function correctly under Memphis. If you are using 
large disk support (FAT32), this program may not run at all.
If you are in the United States, contact Symantec Corporation for information about obtaining new disk utilities 
that were designed for Memphis. You can reach the company at (800) 441-7234 or (541) 334-6054. Outside the 
United States, call the product support telephone number that came with your copy of PC Tools.



You can install Memphis on existing SuperStor compressed drives and existing compressed volume files. 
However, because of incompatibilities, you cannot compress drives using SuperStor after you install Memphis. 
SuperStor/DS uses a file named Defrag.exe to compress a drive. That file is replaced with a newer version during
Memphis Setup, and SuperStor cannot use the newer version of the file.
There are no known versions of SuperStor available for Memphis. If you want to compress a new drive or create a
new compressed volume file, use DriveSpace, which is included with Memphis. Or, obtain a compression 
program that was designed for Memphis.



DoubleTools for DoubleSpace by Addstor is incompatible with Memphis. Do not install this program under 
Memphis. If you do, you will lose access to any existing compressed volume files when you restart your 
computer.



Carbon Copy version 2.5 and earlier does not run under Memphis. If you attempt to run either the host or guest 
components of Carbon Copy, your computer will stop responding. 
If you are in the United States, contact Microcom for information about obtaining a version of this program that is
designed for Memphis. You can reach the company at the following numbers: phone (800) 822-8224; fax (617) 
551-1021; technical support BBS (617) 762-5134, or via the Internet at http://www.microcom.com. Outside the 
United States, call the product support telephone number that came with your copy of Carbon Copy.



This version of your Cyberflix product is incompatible with Memphis. You can obtain an updated version of the 
program from CompuServe or America Online, or visit the Cyberflix Internet site at http://www.cyberflix.com. 
Outside the United States, call the product support telephone number that came with your Cyberflix product.
            To update your Cyberflix product from CompuServe  
            To update your Cyberflix product from America Online  



To update your Cyberflix product from CompuServe HOW TO TEST THESE??

1 Start CompuServe Information Manager, the Windows version of CompuServe.
2 On the Services menu, click GO.
3 In the Go dialog box, type the following:

gamepub
4 Click Index Of Game Publishers
5 Determine which forum Cyberflix games are in, and then click Cancel.
6 Click the appropriate forum. 

If you have not yet joined this forum, you must join it to download the Cyberflix files.
7 Click Cyberflix.
8 On the Library menu, click Browse.
9 Click the program you want to download, and then click Retrieve.
For more information about using CompuServe, see CompuServe Help.



To update your Cyberflix product from America Online

1 On the Go To menu, click Keyword.
2 Type the following:

software
3 Click Go.
4 Click Search The Libraries, and then type the following:

Cyberflix
5 Click List Matching Files, and then click the game you want to download.
6 Click Download Now.
For more information about using America Online, see America Online Help.



If you receive a general protection fault error while trying to run Adobe Illustrator version 4.0, you may be able to
resolve the problem by using the standard VGA display drivers that come with Memphis. If your display is already
set for standard VGA, click the Run Program button.
Click here        for information about changing display drivers.

If you are in the United States, contact Adobe at (800) 833-6687 for information about obtaining a version of this 
program that is designed for Windows 95 and Memphis. Outside the United States, call the product support 
telephone number that came with your copy of Adobe Illustrator.



To change your display driver

1 Click here        to open the Display Properties dialog box.
2 Click Advanced Properties.
3 On the Adapter tab, click Change.
4 Click Show All Devices.
5 In Manufacturers, click Standard Display Types.
6 In Models, click Standard Display Adapter (VGA).
7 Click OK, and then click Close in the Change Display Type and Display Properties dialog boxes.
8 Windows prompts you to restart your computer so the changes you made can take effect. If any programs are 

running, save any unsaved data, and then click Yes.



Memphis does not support the program icons installed by the setup program for EarthCare! Although the setup 
program runs successfully, no icons are created. You can either run EarthCare! by using the Run command or by 
creating an EarthCare! submenu on the Programs menu, and then adding icons to the submenu.
            To run EarthCare! by using the Run command  
            To create a submenu and icons for EarthCare!  



To run EarthCare! by using the Run command

1 Click Start, and then click Run. 
2 In Open, type the following:

x:\pc\earthc.exe
where x is the letter of your CD-ROM drive.



To create a submenu and icons for EarthCare!

1 Right-click Start, and then click Open.
2 Click the Programs folder.
3 On the File menu, point to New, and then click Folder.
4 Type the following name for the folder:

EarthCare!
5 Press ENTER, and then double-click the folder you just created. 
6 On the File menu, point to New, and then click Shortcut.
7 Use the Create Shortcut wizard eight times to create a shortcut for each the following items. For the letter x, 

substitute the letter of your CD-ROM drive.
Command line Shortcut name
x:\pc\earthc.exe EarthCare!
x:\pc\

read_me.wri
Read Me

x:\pc\register.wri Register!
x:\pc\iloveair.wri I Love Air text
x:\pc\iloveani.wri I Love Animals 

text
x:\pc\ilovedrt.wri I Love Dirt text
x:\pc\ilovewtr.wri I Love Water text
x:\pc\songs.wri Words to the 

songs
8 To start an EarthCare! program, click Start, point to Programs, and then point to EarthCare!



If you use a network printer with 3D Home Architect under Memphis, make sure the network path is associated 
with a printer port (this is also referred to as capturing a printer port). Otherwise, you may encounter problems 
when printing to a network printer. 
Click here        for information about capturing a printer port.

If you are in the United States, contact Broderbund Software, Inc. at (800) 521-6263 for information about obtaining
a version of this program that is designed for Memphis. Outside the United States, call the product support 
telephone number that came with your current copy of 3D Home Architect.



To install additional fonts from Microsoft TrueType Font Pack
Click here        for information about adding fonts in Memphis. 



Some of the features of this version of Symantec's Time Line may not work correctly under Memphis. If you 
attempt to use the Tools.run macro and Time Line samples, Time Line will stop responding.
If you are in the United States, contact Symantec at (800) 441-7234 for information about obtaining a version of 
this program that is designed for Memphis. Outside the United States, call the product support telephone 
number that came with your copy of Time Line.



You are about to install Close-Up version 6.0 or Close-Up/LAN Pro version 6.1. Because of changes in the 
Windows 95 and Memphis operating systems, only the Remote side of Close-Up is currently compatible with 
Windows 95 and Memphis.
If you are in the United States, contact Norton-Lambert Corp. for information about obtaining a version of Close-
Up that was designed for Windows 95 and Memphis. You can reach Norton-Lambert in the following ways: phone 
(805) 964-6767 extension 1; fax (805) 683-5679; via the Internet at http://www.norton-lambert.com. Outside the 
United States, call the product support telephone number that came with your current copy of Close-Up.



Do not run the setup program for this version of your Humongous Entertainment product. Because of changes in 
the Windows 95 and Memphis operating systems, installing this program on your computer may result in system 
errors. You can, however, run the program from your CD-ROM by locating either the Autofred.exe or 
Autofarm.exe file, double-clicking it, and then clicking Play. To make starting the program easy, you can add a 
command for it to the Start or Programs menu. 
Click here        for information about adding a command to the Start or Programs menu.

If you are in the United States, contact Humongous Entertainment at (206) 485-1212 for more information. Outside 
the United States, call the product support telephone number that came with your Humongous Entertainment 
product.



Because of changes to the Windows operating system, Symantec C++ Professional version 6.1 and earlier do not
operate correctly under Windows 95 and Memphis.
If you are in the United States, contact Symantec at (800) 441-7234 for information about obtaining a version of 
this program that was designed for Windows 95 and Memphis. Outside the United States, call the product 
support telephone number that came with your copy of Symantec C++ Professional.



Because of changes to the Windows operating system, Upfront version 1.1 may not work under Windows 95 or 
Memphis. 
If you are in the United States, contact SketchTech for more information about this program. You can reach the 
company at the following numbers: phone (612) 379-1435. Outside the United States, call the product support 
telephone number that came with your copy of Upfront.



Because of enhancements to Windows 95 and Memphis display drivers, Proxy does not work under Windows 95 
or Memphis. 
If you are in the United States, contact Funk Software, Inc. for information about a version of this program that 
was designed for Windows 95 and Memphis. You can reach the company in several ways: 
Phone (800) 828-4146
Fax (617) 547-1031
E-mail sales@funk.com
World Wide Web http://www.funk.com/
Outside the United States, call (617) 497-6339.



Because of    changes in the Windows operating system, the WanderLink component named Proxy does not run 
under Windows 95 or Memphis. During WanderLink Client installation, make sure you do not install the Proxy 
Master or Host components.
If you are in the United States, contact Funk Software, Inc. for information about a version of this program that 
was designed for Windows 95 or Memphis. You can reach the company in several ways: 
Phone (800) 828-4146
Fax (617) 547-1031
E-mail sales@funk.com
World Wide Web http://www.funk.com/
Outside the United States, call (617) 497-6339.



Because of enhancements to the graphics drivers in Windows 95 and Memphis, Poetry in Motion does not run 
correctly if your screen is set to a resolution other than 640 by 480. 
Click this        for information about changing your screen resolution to 640 by 480.

If you are in the United States, contact the Voyager Co. at (800) 446-2001 for more information about this program. 
Outside the United States, call the product support telephone number that came with your copy of Poetry in Motion.



Because of changes in the Windows operating system, certain features of this version of Wired for Sound Pro 
may not work correctly under Windows 95 or Memphis. 
You can download an update of Wired for Sound version 4.0 that is compatible with Windows 95 and Memphis 
from the following services:
Service Method

Aristo-Soft BBS Call (510) 426-5641.
CompuServe Type GO ARISTOSOFT.
World Wide Web Connect to http://www.aristosoft.com/
FTP Connect to ftp.aristosoft.com
Email wfs@pacbell.net
Fax (510) 328-1117
Outside the United States, call the product support telephone number that came with your copy of Wired for 
Sound Pro.



When you use a network printer with PerForm PRO, make sure the network path is associated with a printer port 
(this is also referred to as "capturing" a printer port). Otherwise, you may encounter problems when printing to a
network printer.
Click here        for information about capturing a printer port.

If you are in the United States and want more information about PerForm PRO, contact Symantec at (800) 268-
6082; fax (541) 984-2490; or connect to Symantec’s Web site at http://www.symantec.com. Outside the United 
States, call the product support telephone number that came with your copy of PerForm PRO.



Because of changes to the Windows operating system, you cannot run Remotely Possible/Sockets version 1.1 
under Windows 95 or Memphis.
If you are in the United States, contact Avalan Technology, Inc. at (800) 441-2281 or (508) 429-6482 for 
information about obtaining a version of this program that was designed for Windows 95 or Memphis. Or see 
Avalan Technology’s Internet site at http://www.avalan.com. Outside the United States, call the product support 
telephone number that came with your copy of this program.



To install this Lotus product from a computer that is on a network, you need to map a drive letter to the network 
computer.
Click here     for information about mapping a drive letter to a network computer.

If you are in the United States, contact the word processing division of Lotus Development Corp. for information 
about obtaining the latest version of Ami Pro or Word Pro.Windows 95 and later versions of Windows.. You can reach
the company at (800) 343-5414, or visit their Web site at http://www.lotus.com. Outside the United States, call the 
product support telephone number that came with your copy of this program.



Important

Stacker versions 4.1 and earlier are unable to compress drives that use large drive support (FAT32).
For further information, refer to Stac's World Wide Web site at:
http://www.stac.com/



Important

Do not use Stacker versions 4.0 or earlier to compress drives that have long file names. If you do, you will 
truncate long file names to eight-character names with three-character extensions. In addition, Stacker versions 
4.1 and earlier are unable to compress drives that use large drive support (FAT32).
For further information, refer to Stac's World Wide Web site at:
http://www.stac.com/



Versions 2.0 and 2.2 of the Bounds Checker program by Nu-Mega do not work under Windows 95 or Memphis. 
If you are in the United States, contact Nu-Mega for information about obtaining a version of this program that 
was designed for Windows 95 or Memphis. You can reach the company at (800) 468-6342. Outside the United 
States, call the product support telephone number that came with your copy of Bounds Checker.



If you are installing ClarisWorks version 2.0, continue with the installation. If you are installing ClarisWorks 
version 1.0 for Windows, you cannot install the program by using Setup.exe, which is located on disk one. Use 
Setupcw.exe, which is located on disk two, instead. 
If you are in the United States, contact Claris Corp. for information about obtaining a version of this program that
was designed for Windows 95 or Memphis. You can reach the company at the Voice Answerline at 800-735-739, 
the Fax Answerline at 800-800-895, or via the Internet at http://www.claris.com. Outside the United States, call 
the product support telephone number that came with your copy of ClarisWorks. 



This version of Norton AntiVirus was designed to work under Windows 3.1. Because of changes to the Windows 
operating system, some of this program's features do not function correctly under Windows 95 and Memphis. 
If you are in the United States, contact Symantec Corporation for information about obtaining a version of this 
program that was designed for Windows 95 or Memphis. You can reach the company at (800) 441-7234 or (541) 
334-6054. Outside the United States, call the product support telephone number that came with your copy of 
Norton Antivirus. 



This version of Norton Desktop or Norton Backup for Windows was designed to work under Windows 3.1. 
Because of changes to the Windows operating system, some of this program's features do not function correctly 
under Windows 95 and Memphis. In some cases, the program will not work at all.
If you are in the United States, contact Symantec Corporation for information about utilities designed specifically 
for Windows 95 or Memphis. You can reach the company at (800) 441-7234 or (541) 334-6054. Outside the 
United States, call the product support telephone number that came with your copy of Norton Desktop for 
Windows.



This version of Norton Utilities was designed to work with MS-DOS or with Windows 3.1. Because of changes to 
the Windows operating system, some of this program's features do not function correctly under Windows 95 and 
Memphis.
If you are in the United States, contact Symantec Corporation for information about obtaining a version of this 
program that was designed for Windows 95 or Memphis. You can reach the company at (800) 441-7234 or (541) 
334-6054. Outside the United States, call the product support telephone number that came with your copy of 
Norton Utilities.



Because of changes to the Windows operating system, some of Norton Commander's features may not function 
correctly with Windows 95 and Memphis. 
If you are in the United States, contact Symantec Corporation for information about obtaining a version of this 
program that was designed for Windows 95 or Memphis. You can reach the company at (800) 441-7234 or (541) 
334-6054. Outside the United States, call the product support telephone number that came with your copy of 
Norton Commander.



This program was designed for an earlier version of Windows. It does not work correctly under Windows 95 or 
Memphis because of changes in these operating systems. If you try to run this program anyway, make sure you 
first save any work in other running programs.
For more information about this program, contact its manufacturer or your software vendor. 



Although this program works under Windows 95 and Memphis, you may encounter problems when you try to 
print.
For more information about this program, contact its manufacturer or your software vendor.



This program was designed for an earlier version of Windows. It may not work correctly under Windows 95 or 
Memphis because of changes in these operating systems.
For more information about this program, contact its manufacturer or your software vendor.



You may be unable to run this program under Windows 95 or Memphis using certain display settings. If you 
encounter problems, change the number of colors your monitor displays to 256 or 16 colors.
Click here        for information about changing your color palette.

If problems persist, contact the program's manufacturer or your software vendor.



You may be unable to run this program under Windows 95 or Memphis using certain display settings. If you 
encounter problems, change your screen resolution to 640 by 480.
Click this        for information about changing your screen resolution.

If problems persist, contact the program's manufacturer or your software vendor.



Because of the advanced 32-bit networking features in Windows 95 and Memphis, this program may not work 
properly. If you need to continue to use this program, use the networking software that was on your computer 
before you installed Windows 95 or Memphis. For more information, contact your network administrator.
For more information about this program, contact its manufacturer or your software vendor.



Windows 95 or Memphis is capable of detecting many types of hardware. To ensure that your hardware is 
properly set up, use the Add New Hardware wizard to install the drivers for it.
Click here        for information about setting up new hardware.



Do not change the settings for your hardware by using the Control Panel program that came with it. Instead, 
carry out the following procedure.

To change the settings for your hardware

1 Click the Start button, and then point to Settings.
2 Click Control Panel, and then double-click the icon for the hardware you want to change. If there is no icon for 

your hardware, double-click the System icon.
3 Change settings as needed. 

Tip
For Help on an item, click    

    at the top of the dialog box, and then click the item.



For information about running this program under Windows 95 or Memphis, see the Readme.txt file. 

To locate and open the Readme.txt file

1 Click the Start button, point to Find, and then click Files Or Folders.
2 In the Named box, type the following:

readme.txt
3 Click Find Now.

Windows may locate several Readme.txt files.
4 Double-click the Readme.txt file that is located in the folder that contains your Windows files.
5 Search the file for the name of this program.



This MS-DOS program runs correctly under Windows 95 or Memphis on most computers. If it does not run 
correctly on your computer, you may need to run it in MS-DOS mode. MS-DOS mode removes Windows 95 or 
Memphis from memory and creates an MS-DOS environment.

To run this program in MS-DOS mode

1 Quit the program if it is running, and then use My Computer to locate the program's icon.
2 Right-click the program's icon, and then click Properties.
3 Click the Program tab, and then click Advanced.
4 Select the MS-DOS Mode check box.
5 Click OK in all open dialog boxes, and then restart the program.



Running this program under Windows 95 or Memphis may cause Windows to become unstable or may prevent 
Windows from starting correctly. It is recommended that you do not run this program under Windows 95 or 
Memphis.
For more information about this program, contact its manufacturer or your software vendor.



Windows 95 and Memphis allow longer printer names than earlier versions of Windows did. Because of this, it is 
possible to create printer names that your existing programs cannot recognize.
If you have problems printing to a network printer whose name is longer than 14 characters, you can either ask 
your network administrator to rename it, or you can capture the printer port.
Click here        for information about capturing a printer port.



This MS-DOS program requires expanded (EMS) memory to function correctly. If you are using a memory 
manager such as QEMM or 386Max, check the documentation that came with the memory manager for 
information about how to provide EMS memory. If you are using EMM386, carry out the following procedure.

To make sure Emm386.exe is providing expanded memory

1 Click here        to start System Configuration Editor.
2 On the Window menu, click Config.sys.
3  If there are no lines that contain Emm386.exe, your computer is configured correctly. Do not carry out the 

following steps.
If there is a line that contains Emm386.exe, make sure that NOEMS is not included on that line. If it is included,
remove only the NOEMS statement.

4 On the File menu, click Exit. 
5 Click Yes to save your changes. 
6 Restart your computer. EMS memory should now be available to your program.



Do not install this printer driver under Windows 95 or Memphis. Either obtain an updated driver from the 
manufacturer of your printer, or install the driver that comes with Windows 95 or Memphis. To install the 
Windows 95 or Memphis driver, carry out the following procedure.

To install Windows 95 or Memphis printer drivers

1 Click the Start button, point to Settings, and then click Printers.
2 Click the Add Printer icon.
3 Follow the instructions on your screen.



Because of changes to the Windows operating system, you cannot install Famous Places by using Setup.exe. 
Instead, use Fpsetup.exe, which is located in the same folder. The Fpsetup.exe program may not copy some of 
the necessary drivers because of changes in Video for Windows device drivers. To resolve this problem, carry out
the following procedure before you start Famous Places.

To copy the necessary components

1 Write down these instructions, or print them by clicking the Print button in this topic.
2 Finish the Famous Places setup program, and then carry out the following steps.
3 Click the Start button, and then click Run.
4 In the Open box, type the following:

command /c copy x:\indeo.drv %windir%\system /y
For x, substitute the letter of your CD-ROM drive.

5 Click OK. Famous Places should now function correctly.



The Star Trek Interactive Technical Manual installs its animation components on your hard disk in a folder named 
Windows. If the folder that contains your Windows 95 or Memphis files is not named Windows, the animation 
components may not function correctly. To resolve this problem, carry out the following procedure.

To copy Star Trek animation components 

1 Print or write down these instructions.
2 Click the Run Program button, and then finish the Star Trek Interactive Technical Manual setup program.
3 When the setup program is complete, click the Start button, and then click Run.
4 In the Open box, type the following:

command /c copy x:\qtw\*.* %windir%\system /y
For x, substitute the letter of your CD-ROM drive.

5 Click OK.
6 Restart your computer. 



Because of changes to the Windows operating system, you need to add a line to your System.ini file before 
running this program. Write down the following instructions, or print them by clicking the Print button in this 
topic. After the setup program is complete, carry out the following procedure.

To modify your System.ini file
1 Click here        to start System Configuration Editor.

2 On the Window menu, click System.ini.
3 Locate the section titled [386Enh].
4 Add the following line to the [386Enh] section:

device=vwwsd.386
5 On the File menu, click Exit. 
6 Click Yes to save your changes. 
7 Restart your computer. After restarting your computer, the program will be ready to run.



Because of changes to the Windows operating system, you cannot quit Martian Memorandum by pressing 
CTRL+Q. Instead, quit the program by pressing ALT+SPACE and then clicking Close.



Because of changes to the Windows operating system, you cannot quit Amazon – Guardians of Eden by pressing 
CTRL+Q. Instead, quit the program by pressing ALT+SPACE and then clicking Close.



Because of changes to the Windows operating system, you may be unable to run CameraMan for Windows 
version 2.0.
If you are in the United States, contact Motion Works at (415) 541-9333,    email info@motionworks.com, or visit 
the company’s World Wide Web site at http://www.mtw.com for more information about this program. Outside 
the United States, call the product support telephone number that came with your copy of CameraMan.



Because of changes in the Windows operating system, it is recommended that you do not run the Dragon's Lair 
setup program, which copies Dragon's Lair from the CD-ROM to your hard disk. Run the Dragon.exe program 
directly from the CD-ROM instead. To make starting the program easy, you can add a command for it to the Start
or Programs menu.
Click here        for information about adding a command to the Start or Programs menu.



If your computer does not have a math coprocessor, you must run Shadowcaster in MS-DOS mode. If you do not 
know whether your computer has a math coprocessor, save your work in any other programs that are running, 
and then run Shadowcaster. If the game runs correctly, you probably have a math coprocessor and do not need 
to carry out the following procedure. If the game does not run correctly, carry out the following procedure so the 
game runs in MS-DOS mode. MS-DOS mode removes Windows 95 or Memphis from memory and creates an MS-
DOS environment.

To run Shadowcaster in MS-DOS mode

1 Close the program if it is running, and then use My Computer to locate the program's icon.
2 Right-click the program's icon, and then click Properties.
3 Click the Program tab, and then click Advanced.
4 Select the MS-DOS Mode check box.
5 Click OK in all open dialog boxes, and then restart the program.



Because of changes to the Windows operating system, you must rename two files before installing 
TimeActivator. If you do not carry out the following procedure, TimeActivator setup may not complete 
successfully.

To install TimeActivator

1 Click the Start button, point to Find, and then click Files Or Folders. 
2 In the Named box, type the following, and then click Find Now:

odbc*
3 Among the files Windows finds, there should be two that are named Odbc.dll and Odbcinst.dll and are located 

a folder named Windows\System. If the directory that contains your Windows files is not named Windows, a 
different folder name appears instead.

4 Click the Odbc.dll file, and then click the File menu.
5 Click Rename, and then type the following:

odbc.bak
6 Press ENTER, and then click the Odbcinst.dll file.
7 Click the File menu, and then click Rename.
8 Type the following, and then press ENTER.

odbcinst.bak
9 Run the setup program for TimeActivator. Installation should complete successfully.



Because of    changes in the Windows operating system, Alistair and the Alien Invasion may not install correctly 
under Windows 95 or Memphis. To set up Alistair and the Alien Invasion, carry out the following procedure. This 
causes Windows 95 or Memphis to report that it is Windows version 3.1 to the setup program.

To enable the setup program for Alistair and the Alien Invasion to run

1 Click here        to start System Configuration Editor.
2 On the Window menu, click the Win.ini file.
3 Locate the [Compatibility] section.
4 In the [Compatibility] section, type the following text on a line of its own:

DSHELL=0x00200000
5 Click the File menu, and then click Exit.
6 Save your changes to the Win.ini file by clicking Yes.
7 Click the Run Program button to continue setting up Alistair Alien Invasion.
8 Carry out steps 1 through 6 again, but this time remove the text you added to the Win.ini file.



Because of changes to the Windows operating system, you may have problems using Intel Pro Share to capture 
images from 32-bit programs. This is because 16-bit and 32-bit programs run in different contexts. To capture 
images from a 32-bit program, begin by drawing the capture area from inside a 16-bit application. The rectangle 
you draw can include 32-bit programs, but it must begin from a 16-bit program.



If you are installing audio drivers on your IBM ThinkPad while running Windows 95 or Memphis, you may need to 
run the installation program twice to install the drivers correctly.



The sound for Sierra On-Line's Front Page Sports Football Pro '95 does not work correctly under Windows 95 or 
Memphis unless you run the program in MS-DOS mode. MS-DOS mode removes Windows 95 or Memphis from 
memory and creates an MS-DOS environment.

To run Front Page Sports Football Pro 95 in MS-DOS mode

1 Close the program if it is running, and then use My Computer to locate the program's icon.
2 Right-click the program's icon, and then click Properties.
3 Click the Program tab, and then click Advanced.
4 Select the MS-DOS Mode check box.
5 Click OK in all open dialog boxes, and then restart the program.



This game may appear to stop responding after you quit the program. If this is the case, wait for disk activity to 
stop, press ALT+SPACE, and then click Close.
If you are in the United States, contact CUC Software at (800) 757-7707 for more information. Outside the United
States, call the product support telephone number that came with your copy of this game.



If the PATH statement in your Autoexec.bat file exceeds 128 characters, Lotus cc:Mail for Windows version 2.x or 
earlier cannot run under Windows 95 or Memphis. To enable earlier versions of cc:Mail to run if your PATH 
statement exceeds 128 characters, carry out the following procedure.

To reduce the length of your PATH statement

1 Click here        to start System Configuration Editor.
2 If necessary, bring the Autoexec.bat file to the foreground by clicking the Window menu and then clicking 

Autoexec.bat.
3 Locate the PATH statement. Entries in it are separated by semicolons (;).
4 Delete entries for programs that are no longer installed on your computer or for programs that you rarely use.
5 Click the File menu, and then click Exit.
6 Save your changes to the Autoexec.bat file by clicking Yes.
7 Restart your computer, and then run cc:Mail for Windows version 2.0.
If you are in the United States, contact Lotus Development Corporation at (800) 448-2500 for information about 
a version of cc:Mail that was designed for Windows 95 or Memphis. Outside the United States, call (800) 448-
2500 or contact your local software vendor.



Because of    changes in the Windows operating system, this version of ClickBook may not run under Windows 95
or Memphis. If you use this version, your computer may stop responding. 
If you are in the United States, contact Forefront at (415) 354 8161 for information about obtaining an updated 
version of this program, or visit the company’s World Wide Web site at http://www.forefront.com. Outside the 
United States, call the product support telephone number that came with your copy of ClickBook.



This version of Lightning by Lucid Corp. is not supported by Windows 95 or Memphis.
If you are in the United States, contact Lucid Corp. at (800) 967-5550 for more information about this program. 
Outside the United States, call the product support telephone number that came with your copy of Lightning.



Because of changes in the Windows operating system, the Microsoft Mouse driver version 9.01 installation 
program may not work under Windows 95 or Memphis. To resolve this problem, install the IntelliPoint 1.10 
version of the driver.
If you are a registered Microsoft IntelliPoint user, contact Microsoft Customer Service at (800) 426-9400 to add 
your name to the IntelliPoint 1.10 update list. Microsoft will notify you when the IntelliPoint version that is 
designed for Windows 95 or Memphis becomes available. CHECK ON THIS



Following is a list of known problems and solutions for dBASE version 5.0 running under Windows 95 or Memphis.
This information is provided by Borland International.
Problem Cannot RUN() a program when it is located in a LONG DIRECTORY.
Solution Because dBASE version 5.0 for Windows was designed to work with Windows 3.1, you can work around 
this by referencing the long directory using the eight-letter concatenation that dBASE recognizes. Or change to 
the appropriate LONG DIRECTORY before using the RUN() function (so a full path is not needed). Borland now 
provides a new version of dBASE that supports Windows 95 and Memphis.
Problem Minimizing and maximizing a form kills all events. For example, try Animals.wfm from the Samples 
directory.
Solution dBASE version 5.0 for Windows was designed to work with Windows 3.1. This is a known problem for 
which no workaround exists. Borland now provides a new version of dBASE that supports Windows 95 and 
Memphis. This problem does not exist in the new version.
Problem The debugger does not work.
Solution The debugger works correctly if you have set up the appropriate Default.cfg file. dBASE 5.0 for 
Windows was designed to work with Windows 3.1. If you have this problem, call Borland International for a 
program that creates the Default.cfg, or check for this file on the Borland bulletin board or on CompuServe. 
Borland now provides a new version of dBASE that supports Windows 95 and Memphis. The problem does not 
exist in this version.
Problem dBASE becomes unstable after changing the default font for Command Window. This causes the 
"dBASE May Have Become Unstable" message to appear. 
Solution The Command Window Font can be changed, but needs to be done through the Dbasewin.ini file, under
the CommandWindow section. Following is an example of lines using a 13-point Arial font that can be added to 
the CommandWindow section. Simply add these lines to the Dbasewin.ini file. 

InputPaneFont = Arial, 13
ResultsPaneFont = Arial, 13 

dBASE 5.0 for Windows was designed to work with Windows 3.1. Borland now provides a new version of dBASE 
that supports Windows 95 or Memphis. The problem does not exist in this version.
Problem Right-clicking in Browse on the right edge of the screen causes dBASE to stop responding.
Solution dBASE 5.0 for Windows was designed to work with Windows 3.1. This is a known problem for which no 
workaround currently exists. Borland now provides a new version of dBASE that supports Windows 95 or 
Memphis. The problem does not exist in this version.
For information about obtaining a version of dBASE that supports Windows 95 or Memphis, contact Borland 
International. You can reach the company in the following ways: telephone (800) 523-7070 or (408) 431-1064; 
BBS (408) 431-5096; CompuServe GO Borland. Outside the United States, call (408) 431-1000. Borland also has 
a World Wide Web site at:
http:/www.borland.com/



You may encounter problems while running this program under Windows 95 or Memphis. Because of 
enhancements to Windows 95 and Memphis graphics drivers, this program does not run correctly if your screen 
is set to a resolution other than 640 by 480. 
Click this        for information about changing your screen resolution.



This version of the Perceive Personal OCR for Hand Scanners software was written for Windows 3.1 and may not 
work correctly under Windows 95 or Memphis. 
For more information about this program, write to the company at MaxSoft-Ocron, Inc., 4110 Clipper Court, 
Freemont, CA 94538, USA.



Because of changes in the Windows operating system, ExecuVoice by Dragon Systems, Inc., may not work under 
Windows 95 or Memphis. If you use ExecuVoice, it may cause a general protection fault, which may cause 
Windows to stop responding.
If you are in the United States, contact Dragon Systems, Inc. for more information about this program. You can 
reach the company at (800) 825-5897 or (617) 965-5200, or you can visit the company’s World Wide Web site at 
http://www.naturalspeech.com. Outside the United States, call the product support telephone number that came 
with your copy of this program.



Because of changes in the Windows operating system, At Your Service may not work under Windows 95 or 
Memphis. It may also cause Windows to function incorrectly because the program runs automatically every time 
Windows starts.
It is recommended that you do not install this program. Microsoft was unable to obtain information about 
updates for this program. If no updates become available, obtain a similar program that was designed for 
Windows 95 or Memphis.



GroupWise Coaches sometimes demonstrate actions by moving the mouse pointer to the menu bar and then 
simulating a mouse click there. If you use GroupWise version 4.1 under Windows 95 or Memphis, this action may 
fail because Windows 95 and Memphis use a menu font that is different from the font used in previous versions 
of Windows. The simulated mouse click may occur on the wrong menu, causing the Coach to fail. To resolve this 
problem, carry out the following procedure.

To change the font used for menus

1 Click here        to view Display properties.
2 Click the Appearance tab.
3 In the Item list, click Menu.
4 In the Font list, click System.
5 Click OK.



The Meterwin feature, which is included in LANDesk version 2.0 by Intel, may cause Windows to stop responding.
To resolve this problem, remove the command that starts the program automatically every time you start your 
computer.

To prevent Meterwin.exe from starting automatically

1 Click here        to start System Configuration Editor.
2 Click the Window menu, and then click the Win.ini file.
3 Locate the [Windows] section.
4 The file name Meterwin.exe may appear in either the Load= or the Run= line. Remove the file name from the 

line in which it appears.
5 Click the File menu, and then click Exit.
6 Save your changes to the Win.ini file by clicking Yes.
7 Restart your computer.



You cannot use Novell NetWare User Tools with the Microsoft Client for NetWare. Novell NetWare User Tools relies 
on specific dialog boxes to connect NetWare servers. These dialog boxes are not supported by the Microsoft 32-
bit client for NetWare. If you need to continue to use Novell NetWare User Tools, use the networking software 
that was on your computer before you installed Windows 95 or Memphis. For more information, contact your 
network administrator.



Due to changes in the Windows operating system, versions of this setup program that were created before 1995 
may not work correctly. The setup program may not create folders and icons for the main program. To resolve 
this problem, carry out the following procedure.

To create folders and icons for this program

1 Write down these instructions, or print them by clicking the Print button in this topic.
2 Continue the setup program.
3 After the setup program is finished, restart your computer.
4 Click the Start button, and then click Run.
5 In the Open box, type the following, and then click OK.

grpconv
When the GrpConv program has finished running, click the Start button, and then point to Programs. A list of 
several submenus should appear, including one named Pilgrim, which was just created. Point to Pilgrim, and then
click the icon for the program you want to start.



You are using a version of Microsoft Excel that is not fully compatible with Windows 95 and Memphis. Using the 
Print or Print Preview commands may cause Excel to quit unexpectedly. 
If you are in the United States, contact Microsoft at (800) 426-9400 for information about how to work around 
this problem. Outside the United States, call the product support telephone number that came with your copy of 
Excel.



This program was designed for an earlier version of Windows. It may not work correctly under Windows 95 or 
Memphis because of changes in these operating systems.
For more information about this program, contact its manufacturer or your software vendor.



This program was designed for an earlier version of Windows. It may not work correctly under Windows 95 or 
Memphis because of changes in these operating systems.
For more information about this program, contact its manufacturer or your software vendor.



This program was designed for an earlier version of Windows. It may not work correctly under Windows 95 or 
Memphis because of changes in these operating systems.
For more information about this program, contact its manufacturer or your software vendor.



This program was designed for an earlier version of Windows. It may not work correctly under Windows 95 or 
Memphis because of changes in these operating systems.
For more information about this program, contact its manufacturer or your software vendor.



This program was designed for an earlier version of Windows. It may not work correctly under Windows 95 or 
Memphis because of changes in these operating systems.
For more information about this program, contact its manufacturer or your software vendor.



This program was designed for an earlier version of Windows. It may not work correctly under Windows 95 or 
Memphis because of changes in these operating systems.
For more information about this program, contact its manufacturer or your software vendor.



This program was designed for an earlier version of Windows. It may not work correctly under Windows 95 or 
Memphis because of changes in these operating systems.
For more information about this program, contact its manufacturer or your software vendor.
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If you receive a "LINKBUG sees unknown version" message, you have an earlier version of FORTRAN 77 that 
needs to be updated. 
If you are in the United States, contact Absoft for information about obtaining a version of this program that is 
designed for Windows 95 or Memphis. You can reach the company at (248) 853-0050 or (248) 853-0095, or visit 
their World Wide Web site at http://www.absoft.com. Outside the United States, call the product support 
telephone number that came with your copy of FORTRAN 77.



LANDESK version 2.0 and later uses a TSR named Usertsr.exe that may cause Windows 95 or Memphis to stop 
responding when you use the Microsoft IPX/SPX-compatible protocol (Nwlink.vxd) or file and printer sharing for 
Microsoft Networks (Vserver.vxd). 
A version of the TSR that is designed for Windows 95 and Memphis is available on Intel's BBS or from Intel 
product support. For the BBS and product support telephone numbers, consult the documentation that came 
with your copy of LANDESK.



This program was designed for an earlier version of Windows. It may not work correctly under Windows 95 or 
Memphis because of changes in these operating systems. 
For information about a version of this program that was designed for Windows 95 and Memphis, contact 
Traveling Software, Inc., at (800) 487-4320 or (206) 483-8088.



This program may not run correctly if your taskbar setting is Always On Top. Running this program with the 
taskbar on top may cause problems. If you have problems, carry out the following procedure.

To change your taskbar setting
1 Click the Start button, and then point to Settings.
2 Click Taskbar, and then clear the Always On Top check box.
For more information about this program, contact its manufacturer or your software vendor.



Information about ProShareä products is available on Intel's World Wide Web site (www.intel.com) or on Intel's 
CompuServe forum (GO INTEL).



This setup program created PIF files, which you need to delete before you run the program under Windows 95 or 
Memphis. Complete the setup program, and then carry out the following procedure.

To delete PIF files created by this setup program

1 Click the Start button, point to Find, and then click Files Or Folders.
2 Click Browse, and then click the plus (+) sign beside the drive on which you installed the program.
3 Click the folder that contains the program, and then click OK.
4 In the Named box, type the following:

*.pif
5 Click Find Now.
6 Click each PIF file that Windows finds, and then press DEL.
7 Start the program you installed. Windows 95 or Memphis automatically creates a new PIF file that is 

compatible with the new Windows environment.



This backup utility was designed for Windows 3.1. Because of enhancements to the Windows 95 and Memphis 
file systems, which support long file names, this program may not function correctly under Windows 95 or 
Memphis.
For information about obtaining a version of this utility that was designed for Windows 95 or Memphis, contact its
manufacturer or your software vendor.



This version of Central Point Backup was designed for Windows 3.1. Because of changes to the Windows 
operating system, some of this program's features do not function correctly under Windows 95 or Memphis. 
If you are in the United States, contact Symantec Corporation for information about obtaining a version of this 
program that is designed for Windows 95 or Memphis. You can reach the company at the following numbers: 
(800) 441-7234 or (541) 334-6054. Outside the United States, call the product support telephone number that 
came with your copy of this program.



Because of changes in the Windows operating system, switching between Navigator version 2.0 and Windows 95
or Memphis is possible only if you obtain a patch from Packard Bell technical support.
To obtain this patch, contact Packard Bell at (800) 598-3000 or (900) 555-3388.



Because of changes in the Windows operating system, QuickBooks versions 2.0 and 3.0 have problems with 
certain functions in Windows 95 and Memphis.
If you use QuickBooks version 2.0 or 3.0 and also use network printers, you will be unable to print to a network 
printer unless the network path is associated with a printer port (this is also referred to as "capturing" a printer 
port). 
Click here        for information about capturing a printer port.
If you use QuickBooks version 2.0 and want to use Windows 95 or Memphis, carry out the following procedure.

To change QuickBooks so that it works correctly with Windows 95 or Memphis

1 Click here        to start the Make Compatible program.
2 On the File menu, click Choose Program.
3 In the Look In box, click My Computer.
4 Double-click the drive that contains the QuickBooks program. QuickBooks is usually on drive C.
5 Locate the folder that contains the QuickBooks program, and then double-click it.
6 Locate the program icon named QBW, and then double-click it.
7 In the Make Compatible program, select the Win 3.1 Style Controls check box.
8 On the File menu, click Save, and then click Exit.
The latest version of QuickBooks is compatible with Windows 95 and Memphis. To obtain this version, contact 
your software vendor. You can also visit the Intuit Inc. World Wide Web site at http://www.intuit.com.



Microsoft FORTRAN PowerStation for MS-DOS and Windows is designed to work optimally under Windows 3.1. If 
you use Microsoft FORTRAN PowerStation with Windows 95 or Memphis, graphics programs that you compiled 
using the program will fail when you run them. A runtime error appears instead of the usual graphics output.
A patch is available to solve this problem. If you are still using version 1.0 instead of 1.0a, you must obtain an 
updated version of the program. To determine whether you are using version 1.0a, change to the Bin directory, 
and then run Link.exe. If you have version 1.0a, the text "Version 1.0F" should appear. 
To obtain the patch, contact Microsoft product support services at the number listed in your documentation. Or, if
you live in the United States or Canada, call (206) 635-7015. You can also download the self-extracting file 
Fpsfix.exe from the Microsoft Software Library (MSL) on the following services.
Service Method

CompuServe Type GO MSL, and then search for Fpsfix95.exe.
Anonymous FTP At ftp.microsoft.com, change to the \Softlib\Mslfiles directory, and then download Fpsfix95.exe.
You can also visit the Fortran PowerStation support site at http://www.microsoft.com/FortranSupport/
There is also a problem with FORTRAN PowerStation's debug program when it runs under Windows 95 or 
Memphis. Microsoft is currently working on a patch for this problem. WHAT’S THE STATUS??
A variety of CompuServe forums are facilitated by Microsoft and provide an interactive dialogue with a worldwide
community of Microsoft customers. You can exchange information with peers and Microsoft support engineers 
and access the Microsoft Knowledge Base. There is no support charge, but CompuServe connect charges do 
apply. To establish a CompuServe Information Service (CIS) account, call CompuServe directly at (800) 848-8199.



Because of changes in the Windows operating system, this program may not install correctly under Windows 95 
or Memphis. You can resolve this problem by adding a line to your System.ini file. This causes Windows 95 or 
Memphis to report that it is Windows version 3.1 to the setup program.

To enable the setup program to run

1 Write down these instructions, or print them by clicking the Print button in this topic.
2 Click here        to start System Configuration Editor.
3 On the Window menu, click the Win.ini file.
4 Locate the [Compatibility] section.
5 In the [Compatibility] section, type the following text on a line of its own:

DSHELL=0x00200000
6 On the File menu, click Exit.
7 Save your changes to the Win.ini file by clicking Yes.
8 Restart your computer, and then run the setup program.
9 Carry out steps 2 through 7 again, but this time, remove the text you added to the Win.ini file.



Reflection X versions 4.0 and 4.1 do not run under Windows 95 or Memphis. 
If you are in the United States, contact WRQ customer service for more information about this program. You can 
reach the company at the following numbers: phone (206) 217-7100; fax (206) 217-0293; mail WRQ, 1500 
Dexter Avenue North, Seattle WA 98109-3051, USA.
Outside the United States, contact the company as follows: phone +31-70-375-11-00; fax +31-70-356-12-44; 
mail WRQ Europe, Buitenhof 47, 2513 AH Den Haag, The Netherlands.



You need to update the Microsoft Mouse Manager or IntelliPoint program files named Pointer.exe and Pointer.dll 
so you do not receive error messages when using the SnapTo feature. To do this, carry out the following 
procedure.

To update your Pointer.exe and Pointer.dll files

1 Click here        to display Mouse properties. THIS DOESN’T WORK IN MEMPHIS; NEED TO REVISE
2 Click the General tab, and then click Change. 

If a Microsoft mouse is already selected, you do not need to carry out the rest of the steps in this procedure. 
However, you may need to carry out the following procedure.

3 Click Show All Devices.
4 In the Manufacturers list, click Microsoft.
5 In the Models list, click the type of mouse you have, and then click OK. 

This copies the updated versions of Pointer.exe and Pointer.dll from your Windows 95 or Memphis Setup disks 
or CD-ROM to your computer.

Note
· File copy errors will occur if your Autoexec.bat file contains a line that specifies an invalid Mouse or Msinput 

folder on your hard disk, such as "SET MOUSE=C:\MOUSE" or "SET MSINPUT=C:\MSINPUT". If you receive these
errors, print or write down these instructions. Then correct the SET MOUSE or SET MSINPUT line in your 
Autoexec.bat file, restart Windows, and repeat the preceding procedure.

If a Microsoft mouse is selected, but you still receive this warning message when the Mouse Manager or 
IntelliPoint features are started, then the new files were not copied to the correct location on your hard disk. To 
correct this, carry out the following procedure.

To replace older files with the new files you just installed
1 Click the Start button, and then point to Find.
2 Click Files Or Folders, and then type the following in the Named box:

pointer.*
3 Click Find Now. 

Two sets of Pointer files will probably appear. The older versions of these files are typically located in folders 
named C:\Mouse, C:\Msinput, or C:\Msmouse. 

4 Copy the Pointer files from your Windows 95 or Memphis folder to the folder that contains the older versions of
the files, replacing the older files. For more information about copying files, click Related Topics below.

{button ,ALink(“A_COPY_FILES”)} Related Topics



QualiType FontHandler version 1.0 was designed for Windows 3.1. Because the Windows 95 and Memphis 
TrueType subsystem has changed significantly, the functions for installing, uninstalling, and grouping TrueType 
fonts have limited use under Windows 95 and Memphis. However, FontHandler's functions for viewing installed 
fonts, printing sample sheets, and installing, uninstalling, and grouping Adobe Type Manager fonts still works well
with Windows 95 and Memphis. 
If you are in the United States, contact QualiType for more information about a newer version of FontHandler. You
can order an upgraded version by calling (800) 950-2921. For information, call (313) 822-2921 or send e-mail to 
QualiType at 74777.3435@compuserve.com. Or you can visit QualiType’s World Wide Web site at 
http://www.qualitype.com.
Outside the United States, call the product support telephone number that came with your copy of QualiType 
FontHandler.



When you run the Setup program for Microsoft Sound System version 2.0, you will be prompted to replace files 
that are already on your hard disk. Make sure you click No whenever you are prompted to replace existing files. If
you click Yes, your computer may stop responding, and you may have to reinstall Windows 95 or Memphis.



Do not use the Cirrus Logic WinMode utility to change display settings in Windows 95 or Memphis. To adjust your 
screen resolution, color palette, and other settings, double-click the Display icon in Control Panel.

For information 
about

Click
here

Changing the number 
of colors your monitor
displays
Changing your screen 
resolution
Using larger or 
smaller display fonts
Calibrating your 
display to actual 
dimensions

You can configure the refresh rate for your display by using the MS-DOS-based Clmode utility. To do this, carry 
out the following procedure.

To configure the refresh rate for your display

1 Print or write down these instructions.
2 Click the Start button, and then click Shut Down.
3 Click Restart The Computer, and then click Yes.
4 When the text "Starting Memphis . . ." appears, press and release the F8 key.
5 Press 6 to start only a command prompt, and then press ENTER.
6 At the command prompt, type the following:

c:\windows\vgautil\clmode
7 Use the Clmode program to change your refresh rate.
8 Quite the Clmode program, and then restart your computer. 
For an updated version of the WinMode program that is compatible with Windows 95 and Memphis, contact your 
hardware vendor.



Uninstaller 2 was designed for Windows version 3.1 and may not be completely compatible with Windows 95 or 
Memphis. It is recommended that you upgrade to the latest version of Uninstaller, which was designed for 
Windows 95 and Memphis.
For more information, or for support and patches, visit the CyberMedia World Wide Web site at 
http://www.cybermedia.com/support/uninstaller.html.



Important
The Norton Rescue Disk utility may not work properly with this system, because it uses large disk support 
(FAT32). When Setup prompts you to create a Rescue Disk, choose No. To obtain an update that is compatible 
with large disk support, contact Symantec Corporation. Outside the United States, call the product support 
telephone number that came with your Symantec software.
For more information, use one of the following services.
Service Method

Product support Call (800) 441-7234 or (541) 334-6054.
CompuServe Type GO SYMNEW.
America Online Search for the keyword Symantec.
The Microsoft Network Click the Start button, point to Find, and then click On The Microsoft Network. Type 

symantec and then click Find Now.
World Wide Web Connect to http://www.symantec.com/



Important
This version of The Norton Utilities does not work properly with this system, because it uses large disk support 
(FAT32). If you choose to install the program, click No when Setup prompts you to create a Rescue Disk. In 
addition, If you have more than 2 GB of free space on your hard disk, do not install the Norton Protected Recycle 
Bin. To obtain an update that is compatible with large disk support (FAT32), contact Symantec Corporation. 
Outside the United States, call the product support telephone number that came with your Symantec software.
For more information, use one of the following services.
Service Method

Product support Call (800) 441-7234 or (541) 334-6054.
CompuServe Type GO SYMNEW.
America Online Search for the keyword Symantec.
The Microsoft Network Click the Start button, point to Find, and then click On The Microsoft Network. Type 

symantec and then click Find Now.
World Wide Web Connect to http://www.symantec.com/



Important
The Norton Rescue Disk utility does not work properly with this system, because it uses large disk support 
(FAT32). To obtain an update that is compatible with large disk support, contact Symantec Corporation. Outside 
the United States, call the product support telephone number that came with your Symantec software.
For more information, use one of the following services.
Service Method

Product support Call (800) 441-7234 or (541) 334-6054.
CompuServe Type GO SYMNEW.
America Online Search for the keyword Symantec.
The Microsoft Network Click the Start button, point to Find, and then click On The Microsoft Network. Type 

symantec and then click Find Now.
World Wide Web Connect to http://www.symantec.com/



Important
The Norton UnErase feature does not work properly with this system, because it uses large disk support (FAT32). 
To obtain an update that is compatible with large disk support, contact Symantec Corporation. Outside the 
United States, call the product support telephone number that came with your Symantec software.
For more information, use one of the following services.
Service Method

Product support Call (800) 441-7234 or (541) 334-6054.
CompuServe Type GO SYMNEW.
America Online Search for the keyword Symantec.
The Microsoft Network Click the Start button, point to Find, and then click On The Microsoft Network. Type 

symantec and then click Find Now.
World Wide Web Connect to http://www.symantec.com/



Important
The Undo feature of the Norton File Manager does not work properly with this system, because it uses large disk 
support (FAT32). In addition, the Deleted files tab of the Norton File Manager does not show files on a FAT32 
drive. To obtain an update that is compatible with large disk support, contact Symantec Corporation. Outside the 
United States, call the product support telephone number that came with your Symantec software.
For more information, use one of the following services.
Service Method

Product support Call (800) 441-7234 or (541) 334-6054.
CompuServe Type GO SYMNEW.
America Online Search for the keyword Symantec.
The Microsoft Network Click the Start button, point to Find, and then click On The Microsoft Network. Type 

symantec and then click Find Now.
World Wide Web Connect to http://www.symantec.com/



This version of Speed Disk is unable to optimize drives using large disk support (FAT32). In addition, it is unable 
to optimize the swap file with Windows 95 or Memphis. To obtain an update that is compatible with this version 
of Windows, contact Symantec Corporation. Outside the United States, call the product support telephone 
number that came with your Symantec software.
For more information, use one of the following services.
Service Method

Product support Call (800) 441-7234 or (541) 334-6054.
CompuServe Type GO SYMNEW.
America Online Search for the keyword Symantec.
The Microsoft Network Click the Start button, point to Find, and then click On The Microsoft Network. Type 

symantec and then click Find Now.
World Wide Web Connect to http://www.symantec.com/



Important
Norton Disk Doctor will not work properly with this system. Because of changes made in Windows 95 and 
Memphis, Norton Disk Doctor may incorrectly report errors with the media byte on most hard disks. In addition, 
Disk Doctor will be unable to check any drives that are using large disk support (FAT32). To obtain an update that
is compatible with this version of Windows, contact Symantec Corporation. Outside the United States, call the 
product support telephone number that came with your Symantec software.
For more information, use one of the following services.
Service Method

Product support Call (800) 441-7234 or (541) 334-6054.
CompuServe Type GO SYMNEW.
America Online Search for the keyword Symantec.
The Microsoft Network Click the Start button, point to Find, and then click On The Microsoft Network. Type 

symantec and then click Find Now.
World Wide Web Connect to http://www.symantec.com/



Important
This version of the Norton Utilities does not work properly with this system, because the system uses large disk 
support (FAT32). The Disk Image utility is unable to create images of any drives using large disk support. You 
should reconfigure Norton System Doctor so that it will not automatically try to create image information for 
these drives. In addition, Norton Disk Doctor will be unable to check drives using large disk support (FAT32), and 
will incorrectly report errors on hard disks. Speed Disk will also be unable to optimize drives that use large disk 
support. To remove System Doctor sensors for Image, Disk Integrity, and Fragmentation, right-click each sensor, 
and then click Remove. In addition, if you have more than 2 GB of free space on your hard disk, do not enable 
Norton Protection on your Recycle Bin. To obtain an update that is compatible with large disk support (FAT32), 
contact Symantec Corporation. Outside the United States, call the product support telephone number that came 
with your Symantec software.
For more information, use one of the following services.
Service Method

Product Support Call (800) 441-7234 or (541) 334-6054.
CompuServe Type GO SYMNEW.
America Online Search for the keyword Symantec.
The Microsoft Network Click the Start button, point to Find, and then click On The Microsoft Network. Type 

symantec and then click Find Now.
World Wide Web Connect to http://www.symantec.com/



Important

This version of F-PROT Professional cannot scan the boot sectors of hard disks using large disk support (FAT32). 
In addition, the progress gauge may reach 100% too quickly on FAT32 drives. If you attempt to scan a FAT32 boot
sector for viruses, a warning message will appear. To continue, click OK and the file scan will continue normally. 
To suppress the warning dialog box, you can disable boot sector scanning. To do this, select the Scan Hard Drives
task in F-PROT Professional, click the Task menu, click Properties, and clear the Boot Sectors check box.
For more information, contact Command Software at one of the following services.
Service Method

Address 1061 E. Indiantown Road, Suite 
500, Jupiter, FL 33477

Sales Call (800) 423-9147
Product support Call (561) 575-3200.
Fax: Call (561) 575-3026.
BBS Dial (561) 575-1281.
CompuServe Type GO FPROT.
FTP Connect to ftp.commandcom.com
World Wide Web Connect to 

http://www.commandcom.com/



Important

This version of Dunce was designed for an earlier version of Windows. It did not always work properly with 
Windows 95, and it may not work properly with Memphis.
To obtain an update that is compatible with this version of Windows, contact Vector Development at one of the 
following services:
Service Method

Phone (913) 539-6106
Mail Vector Development

P.O. Box 831
Manhattan, KS 66505-0831

Internet e-mail vecdev@cjnetworks.com
World Wide Web http://www.vecdev.com

Important

This version of PartitionMagic may not function properly on this computer, because the drive is using large disk 
support (FAT32).
To obtain an update that works with FAT32 drives, contact PowerQuest Corporation at one of the following 
services.
Service Method

US Sales (800) 379-2566
Int’l Sales (801) 437-8900
Fax (801) 226-8941
Customer Service (801) 226-8977.
Internet e-mail magic@powerquest.com
World Wide Web http://www.powerquest.com/
CIS: Compuserve 74601,354

Important

This program may not function properly on this computer, because it is using large disk support (FAT32).
To obtain an update that is compatible with FAT32 drives, contact Helix Software Company at one of the following
services.
Service Method

Address 47-09 30th St.
Long Island City, NY    11101

Phone (800) 451-0551 or (718) 392-3100.
Fax (718) 392-4212
BBS (718) 392-4054
CompuServe GO HELIX
Internet e-mail support@helixsoftware.com
World Wide Web http://www.helixsoftware.com/

Important

This version of d-Time may not function properly on this computer, because it is using large disk support (FAT32).



To obtain an update that is compatible with large disk support, contact Acceleration Software    by one of the 
following methods.
Service Method

Technical Support (360) 598-2456.
Internet e-mail 

support@accelerationsw.com
World Wide Web http://www.accelerationsw.com



Important

Two drivers used during the optimize process of QEMM version 8.0 have minor incompatibilities with Windows 95 and Memphis. 
Quarterdeck Corp. can provide you with new versions of these two drivers, Dosdata.sys and Dos-up.sys. They are available for 
download from the following locations:

BBS (310) 309 3227 

CompuServe GO QUARTERDECK

World Wide Web http://www.quarterdeck.com/

If you do not have access to these locations, please call Quarterdeck Customer Service at (800) 354-3222. Outside the United 
States, please contact Quarterdeck via the methods listed in your QEMM manual.



CleanSweep: Do Not Install CleanSweep 3.0 with Internet Explorer 4.0

Installing CleanSweep 3.0 after you install the Internet Explorer 4.0 Preview Release is not recommended. 
CleanSweep replaces some vital system files and causes Internet Explorer not to work properly.
If you must install CleanSweep, carry out the following steps: 
1 Find and make back-up copies of the following files:

Urlmon.dll
Wininet.dll

2 Install CleanSweep, and then restart your computer.
3 Start Internet Explorer 4.0.
4 If Internet Explorer 4.0 is not working properly, restart your computer in MS-DOS mode.
5 Replace the existing Urlmon.dll and Wininet.dll files with the back-up copies you made in step 1.
6 Type WIN at the command prompt to restart Windows, then start Internet Explorer.

Note
If you have already installed CleanSweep, you can try uninstalling and then reinstalling Internet Explorer 

4.0.



InterLeap 1.1

Do not run the InterLeap 1.1 address bar replacement application with Internet Explorer 4.0.    If you do, you will 
not be able to restart the operating system.    Please contact the vendor for an upgrade.



Internet Explorer 3.02

DO NOT install previous versions of Internet Explorer over Internet Explorer 4.0.    Older versions of IE will not 
permit IE4.0 to function properly.    If an older version of IE is accidentally installed on top of IE4.0, you should 
uninstall IE and reinstall IE4.0




